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Abstract—These instructions give you guidelines for preparing 

papers for the FGSA Research Symposium. Use this document as 

a template and as an instruction set. This document is modeled 

after guidelines for submission to IEEE journals. The electronic 

file of your paper will be formatted further by the symposium 

committee if chosen as a winner and accepted for publication. 

Define all symbols used in the abstract. Do not cite references in 

the abstract. Do not delete the blank line immediately above the 

abstract; it sets the footnote at the bottom of this column. 

 
Index Terms—About four key words or phrases in alphabetical 

order, separated by commas. You can visit the IEEE web site at 

http://www.ieee.org/organizations/pubs/ani_prod/keywrd98.txt 
for a list of common keywords used in journal articles. 

 

I. INTRODUCTION 

HIS document is a template for Microsoft Word 

versions 6.0 or later.  

When you open FGSA PAPER TEMPLATE.DOC, select 

“Page Layout” from the “View” menu in the menu bar (View | 

Page Layout), which allows you to see the footnotes. Then 

type over sections of FGSA PAPER TEMPLATE.DOC or cut 

and paste from another document and then use markup styles. 

The pull-down style menu is at the left of the Formatting 

Toolbar at the top of your Word window (for example, the 

style at this point in the document is “Text”). Highlight a 

section that you want to designate with a certain style, then 

select the appropriate name on the style menu. The style will 

adjust your fonts and line spacing. Do not change the font 

sizes or line spacing to squeeze more text into a limited 

number of pages. Use italics for emphasis; do not underline.  

To insert images in Word, position the cursor at the 
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insertion point and either use Insert | Picture | From File or 

copy the image to the Windows clipboard and then Edit | Paste 

Special | Picture (with “Float over text” unchecked).  

II. PROCEDURE FOR PAPER SUBMISSION 

A. Review Stage 

Please submit your manuscript by hard copy and 

electronically for review. The hard copies should be submitted 

in triplicate, submit photocopies such that only one column 

appears per page. This will give your reviewers plenty of room 

to write comments. Submit electronically via the FGSA 

blackboard. If you want to submit your file with one column 

electronically, please do the following: 

 --First, click on the View menu and choose Print Layout. 

 --Second, place your cursor in the first paragraph. Go to 

the Format menu, choose Columns, choose one column 

Layout, and choose “apply to whole document” from the 

dropdown menu. 

 --Third, click and drag the right margin bar to just over 4 

inches in width. 

The graphics will stay in the “second” column, but you can 

drag them to the first column. Make the graphic wider to push 

out any text that may try to fill in next to the graphic. 

B. Final Stage 

If selected as a winner, when you submit your final version,  

print it in two-column format, including figures and tables. 

Submit the document electronically, you will be notified to 

whom to send it to if your paper is selected as a winner. 

Also send a sheet of paper with complete contact 

information for all authors. Include full mailing addresses, 

telephone numbers, fax numbers, and e-mail addresses. This 

information will be used to send each author a complimentary 

copy of the publication in which the paper appears. In 

addition, designate one author as the “corresponding author.” 

This is the author to whom correspondence will be sent 

C. Figures 

All tables and figures will be processed as images. 

However, FGSA Research Symposium Committee cannot 

extract the tables and figures embedded in your document. 

(The figures and tables you insert in your document are only to 

help you gauge the size of your paper, for the convenience of 

the referees, and to make it easy for you to distribute 

preprints.) Thus if you are selected as a winner, you will be 
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asked to submit, on separate sheets of paper, enlarged 

versions of the tables and figures that appear in your 

document. These are the images FGSA Research Symposium 

Committee will scan and publish with your paper.  

D. Electronic Image Files (Optional) 

You will have the greatest control over the appearance of 

your figures if you are able to prepare electronic image files. If 

you do not have the required computer skills, just submit paper 

prints as described above and skip this section. 

1) Easiest Way: If you have a scanner, the best and quickest 

way to prepare noncolor figure files is to print your tables and 

figures on paper exactly as you want them to appear, scan 

them, and then save them to a file in PostScript (PS) or 

Encapsulated PostScript (EPS) formats. Use a separate file for 

each image. File names should be of the form “fig1.ps” or 

“fig2.eps.” 

2) Slightly Harder Way: Using a scanner as above, save the 

images in TIFF format. High-contrast line figures and tables 

should be prepared with 600 dpi resolution and saved with no 

compression, 1 bit per pixel (monochrome), with file names of 

the form “fig3.tif” or “table1.tif.” To obtain a 3.45-in figure 

(one-column width) at 600 dpi, the figure requires a horizontal 

size of 2070 pixels. Typical file sizes will be on the order of 

0.5 MB. 

Photographs and grayscale figures should be prepared with 

220 dpi resolution and saved with no compression, 8 bits per 

pixel (grayscale). To obtain a 3.45-in figure (one-column 

width) at 220 dpi, the figure should have a horizontal size of 

759 pixels.  

Color figures should be prepared with 400 dpi resolution 

and saved with no compression, 8 bits per pixel (palette or 256 

color). To obtain a 3.45-in figure (one column width) at 400 

dpi, the figure should have a horizontal size of 1380 pixels.  

For more information on TIFF files, please go to 

http://www.ieee.org/organizations/pubs/transactions/informatio

n.htm and click on the link “Guidelines for Author Supplied 

Electronic Text and Graphics.” 

3) Somewhat Harder Way: If you do not have a scanner, 

you may create noncolor PostScript figures by “printing” them 

to files. First, download a PostScript printer driver from 

http://www.adobe.com/support/downloads/pdrvwin.htm (for 

Windows) or from http://www.adobe.com/support/downloads/ 

pdrvmac.htm (for Macintosh) and install the “Generic 

PostScript Printer” definition. In Word, paste your figure into a 

new document. Print to a file using the PostScript printer 

driver. File names should be of the form “fig5.ps.” Use Adobe 

Type 1 fonts when creating your figures, if possible.  

4) Other Ways: Experienced computer users can convert 

figures and tables from their original format to TIFF. Some 

useful image converters are Adobe Photoshop, Corel Draw, 

and Microsoft Photo Editor, an application that is part of 

Microsoft Office 97 and Office 2000 (look for C:\Program 

Files\Common Files \Microsoft Shared\ PhotoEd\ 

PHOTOED.EXE. (You may have to custom-install Photo 

Editor from your original Office disk.) 

Here is a way to make TIFF image files of tables. First, 

create your table in Word. Use horizontal lines but no vertical 

lines. Hide gridlines (Table | Hide Gridlines). Spell check the 

table to remove any red underlines that indicate spelling errors. 

Adjust magnification (View | Zoom) such that you can view 

the entire table at maximum area when you select View | Full 

Screen. Move the cursor so that it is out of the way. Press 

“Print Screen” on your keyboard; this copies the screen image 

to the Windows clipboard. Open Microsoft Photo Editor and 

click Edit | Paste as New Image. Crop the table image (click 

Select button; select the part you want, then Image | Crop). 

Adjust the properties of the image (File | Properties) to 

monochrome (1 bit) and 600 pixels per inch. Resize the image 

(Image | Resize) to a width of 3.45 inches. Save the file (File | 

Save As) in TIFF with no compression (click “More” button).  

Most graphing programs allow you to save graphs in TIFF; 

however, you often have no control over compression or 

number of bits per pixel. You should open these image files in 

a program such as Microsoft Photo Editor and re-save them 

using no compression, either 1 or 8 bits, and either 600 or 220 

dpi resolution (File | Properties; Image | Resize). See Section 

II-D2 for an explanation of number of bits and resolution. If 

your graphing program cannot export to TIFF, you can use the 

same technique described for tables in the previous paragraph. 

A way to convert a figure from Windows Metafile (WMF) 

to TIFF is to paste it into Microsoft PowerPoint, save it in JPG 

format, open it with Microsoft Photo Editor or similar 

converter, and re-save it as TIFF. 

Microsoft Excel allows you to save spreadsheet charts in 

Graphics Interchange Format (GIF). To get good resolution, 

make the Excel charts very large. Then use the “Save as  

 

HTML” feature (see http://support.microsoft.com/support/ 

kb/articles/q158/0/79.asp). You can then convert from GIF to 

TIFF using Microsoft Photo Editor, for example. 

No matter how you convert your images, it is a good idea to 

 
Fig. 1.  Magnetization as a function of applied field. Note that “Fig.” is 

abbreviated. There is a period after the figure number, followed by two 

spaces. It is good practice to explain the significance of the figure in the 

caption. 
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print the TIFF files to make sure nothing was lost in the 

conversion.  

III. MATH 

If you are using Word, use either the Microsoft Equation 

Editor or the MathType add-on (http://www.mathtype.com) for 

equations in your paper (Insert | Object | Create New | 

Microsoft Equation or MathType Equation). “Float over text” 

should not be selected.  

 

IV. UNITS 

Use either SI (MKS) or CGS as primary units. (SI units are 

strongly encouraged.) English units may be used as secondary 

units (in parentheses). This applies to papers in data storage. 

For example, write “15 Gb/cm
2
 (100 Gb/in

2
).” An exception is 

when English units are used as identifiers in trade, such as “3½ 

in disk drive.” Avoid combining SI and CGS units, such as 

current in amperes and magnetic field in oersteds. This often 

leads to confusion because equations do not balance 

dimensionally. If you must use mixed units, clearly state the 

units for each quantity in an equation. 

The SI unit for magnetic field strength H is A/m. However, 

if you wish to use units of T, either refer to magnetic flux 

density B or magnetic field strength symbolized as µ0H. Use 

the center dot to separate compound units, e.g., “A·m
2
.” 

 

V. HELPFUL HINTS 

A. Figures and Tables 

Position figures and tables at the top and bottom of each 

column. All figures, figure captions, and tables should be 

placed in the text of the paper. Large figures and tables may 

span both columns. Place figure captions below the figures; 

place table titles above the tables. If your figure has two parts, 

include the labels “(a)” and “(b)” as part of the artwork. Please 

verify that the figures and tables you mention in the text 

actually exist. Please do not include captions as part of the 

figures. Do not put captions in “text boxes” linked to the 

figures. Do not put borders around the outside of your 

figures. Use the abbreviation “Fig.” even at the beginning of a 

sentence. Do not abbreviate “Table.” Tables are numbered 

with Roman numerals.  

Do not use color unless it is necessary for the proper 

interpretation of your figures. 

Figure axis labels are often a source of confusion. Use 

words rather than symbols. As an example, write the quantity 

“Magnetization,” or “Magnetization M,” not just “M.” Put 

units in parentheses. Do not label axes only with units. As in 

Fig. 1, for example, write “Magnetization (A/m)” or 

“Magnetization (A ⋅m
−1
),” not just “A/m.” Do not label axes 

with a ratio of quantities and units. For example, write 

“Temperature (K),” not “Temperature/K.”  

Multipliers can be especially confusing. Write 

“Magnetization (kA/m)” or “Magnetization (10
3
 A/m).” Do 

not write “Magnetization (A/m) × 1000” because the reader 

would not know whether the top axis label in Fig. 1 meant 

16000 A/m or 0.016 A/m. Figure labels should be legible, 

approximately 8 to 12 point type. 

B. References 

Number citations consecutively in square brackets [1]. The 

sentence punctuation follows the brackets [2]. Multiple 

references [2], [3] are each numbered with separate brackets 

[1]–[3]. When citing a section in a book, please give the 

relevant page numbers [2]. In sentences, refer simply to the 

reference number, as in [3]. Do not use “Ref. [3]” or 

“reference [3]” except at the beginning of a sentence: 

“Reference [3] shows ... .”  

Number footnotes separately in superscripts (Insert | 

Footnote).
1
 Place the actual footnote at the bottom of the 

column in which it is cited; do not put footnotes in the 

reference list (endnotes). Use letters for table footnotes (see 

Table I).  

Please note that the references at the end of this document 

are in the preferred referencing style. Give all authors’ names; 

do not use “et al.” unless there are six authors or more. Use a 

space after authors' initials. Papers that have not been 

published should be cited as “unpublished” [4]. Papers that 

have been submitted for publication should be cited as 

“submitted for publication” [5]. Papers that have been 

accepted for publication, but not yet specified for an issue 

should be cited as “to be published” [6]. Please give 

affiliations and addresses for private communications [7]. 

Capitalize only the first word in a paper title, except for 

proper nouns and element symbols. For papers published in 

translation journals, please give the English citation first, 

followed by the original foreign-language citation [8]. 

C. Abbreviations and Acronyms 

Define abbreviations and acronyms the first time they are 

used in the text, even after they have already been defined in 

the abstract. Abbreviations such as IEEE, SI, ac, and dc do not 

have to be defined. Abbreviations that incorporate periods 

should not have spaces: write “C.N.R.S.,” not “C. N. R. S.” Do 

not use abbreviations in the title unless they are unavoidable 

(for example, “IEEE” in the title of this article). 

D. Equations 

Number equations consecutively with equation numbers in 

parentheses flush with the right margin, as in (1). First use the 

equation editor to create the equation. Then select the 

“Equation” markup style. Press the tab key and write the 

equation number in parentheses. To make your equations more 

compact, you may use the solidus ( / ), the exp function, or 

appropriate exponents. Use parentheses to avoid ambiguities in 

denominators. Punctuate equations when they are part of a 

 
1It is recommended that footnotes be avoided (except for the unnumbered 

footnote with the receipt date on the first page). Instead, try to integrate the 

footnote information into the text. 
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sentence, as in 
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Be sure that the symbols in your equation have been defined 

before the equation appears or immediately following. Italicize 

symbols (T might refer to temperature, but T is the unit tesla). 

Refer to “(1),” not “Eq. (1)” or “equation (1),” except at the 

beginning of a sentence: “Equation (1) is ... .” 

E. Other Recommendations 

Use one space after periods and colons. Hyphenate complex 

modifiers: “zero-field-cooled magnetization.” Avoid dangling 

participles, such as, “Using (1), the potential was calculated.” 

[It is not clear who or what used (1).] Write instead, “The 

potential was calculated by using (1),” or “Using (1), we 

calculated the potential.” 

Use a zero before decimal points: “0.25,” not “.25.” Use 

“cm
3
,” not “cc.” Indicate sample dimensions as “0.1 cm × 0.2 

cm,” not “0.1 × 0.2 cm2
.” The abbreviation for “seconds” is 

“s,” not “sec.” Do not mix complete spellings and 

abbreviations of units: use “Wb/m
2
” or “webers per square 

meter,” not “webers/m
2
.” When expressing a range of values, 

write “7 to 9” or “7-9,” not “7~9.” 

A parenthetical statement at the end of a sentence is 

punctuated outside of the closing parenthesis (like this). (A 

parenthetical sentence is punctuated within the parentheses.) In 

American English, periods and commas are within quotation 

marks, like “this period.” Other punctuation is “outside”! 

Avoid contractions; for example, write “do not” instead of 

“don’t.” The serial comma is preferred: “A, B, and C” instead 

of “A, B and C.” 

If you wish, you may write in the first person singular or 

plural and use the active voice (“I observed that ...” or “We 

observed that ...” instead of “It was observed that ...”). 

Remember to check spelling. If your native language is not 

English, please get a native English-speaking colleague to 

proofread your paper.  

 

VI. SOME COMMON MISTAKES 

The word “data” is plural, not singular. The subscript for the 

permeability of vacuum µ0 is zero, not a lowercase letter “o.” 

The term for residual magnetization is “remanence”; the 

adjective is “remanent”; do not write “remnance” or 

“remnant.” Use the word “micrometer” instead of “micron.” A 

graph within a graph is an “inset,” not an “insert.” The word 

“alternatively” is preferred to the word “alternately” (unless 

you really mean something that alternates). Use the word 

“whereas” instead of “while” (unless you are referring to 

simultaneous events). Do not use the word “essentially” to 

mean “approximately” or “effectively.” Do not use the word 

“issue” as a euphemism for “problem.” When compositions 

are not specified, separate chemical symbols by en-dashes; for 

example, “NiMn” indicates the intermetallic compound 

Ni0.5Mn0.5 whereas “Ni–Mn” indicates an alloy of some 

composition NixMn1-x. 

Be aware of the different meanings of the homophones 

“affect” (usually a verb) and “effect” (usually a noun), 

“complement” and “compliment,” “discreet” and “discrete,” 

“principal” (e.g., “principal investigator”) and “principle” 

(e.g., “principle of measurement”). Do not confuse “imply” 

and “infer.”  

Prefixes such as “non,” “sub,” “micro,” “multi,” and 

“"ultra” are not independent words; they should be joined to 

the words they modify, usually without a hyphen. There is no 

period after the “et” in the Latin abbreviation “et al.” (it is also 

italicized). The abbreviation “i.e.,” means “that is,” and the 

abbreviation “e.g.,” means “for example” (these abbreviations 

are not italicized). 

An excellent style manual and source of information for 

science writers is [9]. A general IEEE style guide, Information 

for Authors, is available at 

http://www.ieee.org/organizations/pubs/transactions/informatio

n.htm 

VII. CONCLUSION 

A conclusion section is not required. Although a conclusion 

may review the main points of the paper, do not replicate the 

abstract as the conclusion. A conclusion might elaborate on the 

importance of the work or suggest applications and extensions. 

The paper with all included figures, tables, appendices and 

references will not exceed 6 pages. 

APPENDIX 

Appendixes, if needed, appear before the acknowledgment. 

ACKNOWLEDGMENT 

The preferred spelling of the word “acknowledgment” in 

American English is without an “e” after the “g.” Use the 

singular heading even if you have many acknowledgments. 

Avoid expressions such as “One of us (S.B.A.) would like to 

thank ... .” Instead, write “F. A. Author thanks ... .” Sponsor 

and financial support acknowledgments are placed in the 

unnumbered footnote on the first page. 
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